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1 System Description

1.1 Cautions and Warnings
The EVM is designed to operate from AC supply or high voltage DC supply by professionals who have
received appropriate technical training. Please read the safety related documents that come with the EVM
package and user's guide before operating the EVM.

CAUTION
Read user guide before use.

CAUTION
Do not leave the EVM powered when unattended.

CAUTION
HOT SURFACE: Contact may cause burns. Do not
touch.

CAUTION
HIGH VOLTAGE: Electric shock possible when
connecting board to live wire. The board should be
handled with care by a professional. For safety, use
isolated equipment with overvoltage and overcurrent
protection.

This document discuss an application of a single-phase AC and DC power monitor (or server power
monitor) using a simple, low-cost Texas Instruments MCU MSP430i2040. The MSP430i2040 is a mixed
signal microcontroller. The MCU integrates with four differential input 24-bit sigma-delta (SD24) A/D
converters (ADCs) with programmable gain amplifier, a 16-bit hardware multiplier, an SPI communication
interface, and an eUSCI_A0 supports UART. The eUSCI_B0 supports SPI, I2C, two 16-bit timer, and 12
GPIO pins in a 28-pin TSSOP or 16 GPIO pins in a 32-pin QFN package. The peripheral set is a good
combination to measure electrical power.

This document uses the default firmware and the original EVM hardware design to describe the setup,
operations, features, behaviors, functions, and interfacing. Proper functionality is not guaranteed if
changes made to hardware or firmware.

For more information about the EVM, see the EVM430-i2040SUBMTR User’s Guide.
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2 Design Features

2.1 Basic Operations
This design uses three SD24 ADCs on the MCU: one to measure voltage, one to measure current, and
the other one connects to the built-in temperature sensor to measure temperature. The sigma-delta ADC
runs approximately at a 1.024-MHz modulator frequency fixed by the hardware. The sample frequency
derives from the modulator frequency divided by 128 equals 8 kHz, which give us a Nyquist bandwidth of
4 kHz. This bandwidth is sufficient to cover the 66th harmonic for 60-Hz AC. The 80th harmonic for 50-Hz
AC frequency as a wider bandwidth is usually needed for server power monitoring due to the nature of the
switching power supplies.

Figure 1 shows the system functional diagram. The two SD24 ADCs take samples from the voltage and
the current channel with the (calibrated and programmed) fractional delay. The samples then pass through
a DC removal filter. Each DC removal filter dynamically tracks the DC offset of the ADC and the signal by
analyzing each sample and removes the DC (from signal and from ADC-DC offset) before passing the
sample to further processing. If the operation is in DC mode, the DC removal filter only removes the DC
offset of the ADC.

The current sample and the voltage sample then performs a square and accumulates to get the root mean
square current (IRMS) and voltage (VRMS). The current sample also multiplies and accumulates with the
voltage sample with proper additional phase delay (if needed) to get the active power (Pactive) and with the
corresponding 90-degree shifted sample to get the reactive power (Preactive). The EVM then uses an
internally generated pure sine wave amplitude and phase synchronized with the AC voltage input together
with the 90 degree-shifted version to multiply and accumulate with the current sample to get the
fundamental active and fundamental reactive power.

The cycle detection mechanism detects the presence of an AC signal by checking the number of zero
crossings over a pre-defined time. If the number of zero crossings is less than the expected number of
zero crossings minus 1, then the cycle is in DC mode; otherwise, the cycle is in AC mode. This
mechanism works well for the frequency from 25 Hz when the pre-defined determination interval is set to
80 ms.

After four AC cycles (or 80 ms in DC mode), the system sets a flag to show results that need to process.
The flag then triggers this system to perform the scaling and convert these accumulated values into values
of proper unit (V, A, W, and so on).

Figure 1. System Functional Diagram
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3 Block Diagram

Figure 2. System Block Diagram

3.1 Interface Circuit
The key factor of a successful and accurate metering circuit design very much depends on a good
sampling circuit. The 24-bit sigma-delta ADC on the MSP430i2040, together with the on-chip
programmable gain amplifier, provides the critical hardware for getting high quality AD conversion results
from both the current and voltage sensor. Moreover, the interface circuit, the component selection, and the
circuit layout also play a crucial role for a successful design.

Due to the nature of a sigma-delta ADC and of the voltage and current signals being measured, an
external interface circuit is needed to interface the voltage and current to keep the sigma-delta ADC to
work properly and provide proper filtering for a band of interest.

The hardware of the interface circuit consists of simple, passive components apart from the protection
diode. Figure 3 shows the interface circuit designed. The top circuit is the interface to the voltage sensor
and the bottom circuit is for the current sensor (or the shunt resistor).

In the current sensor interface circuit with R6 being the shunt sensor, D1 is the optional protection diode.
The protection diode is not required unless, for example, a high shunt resistor value or a current
transformer is in use instead of the current sensor, and the user anticipates a significant current surge to
cause enough voltage across the sensor to damage the MCU.

L1, R9, and C9 forms a low pass filter having a bandwidth of a few MHz. The purpose of this filter is to
reject radio frequency interference from going into the sigma-delta ADC. The filter formed by L2, R8, and
C8 has the same characteristic, which is balanced for the differential signal. The filter formed by R9, R8,
and C10 is a filter that gives a bandwidth of about 10 kHz, which is the filter for the band of interest.

The order of magnitude of these capacitors should be observed although the actual value of the
capacitance is not that critical.
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The voltage sensor interface is a resistor ladder. The ratio of the resistance in the resistor ladder allows up
to 308-V AC and 420-V DC to be measured. The current sensor filter is similar except that the value of
R10 is 100 Ω, not 1 kΩ. The reason for this is the voltage divider circuit has an equivalent source

resistance in series with R10. To balance the filter for the differential signal, the
sensor uses a small R10 value. The combined effect is of similar value to R11. Although there is a slight
mismatch using the designed value, this effect has no observable impact to accuracy.

Figure 3. Voltage and Current Sensor Interface Circuit

3.2 Component Considerations

3.2.1 Shunt Resistor
For accurate measurements, the choice of shunt is another important factor. In practice, a shunt of smaller
value is a better choice. Smaller shunt values benefit the power dissipated on the shunt and the respective
rise in temperature. The lower rise in temperature reduces the need for a very low temperature coefficient
shunt resistor to sustain accuracy. However, using a small value shunt has a drawback as well in that the
signal-to-noise ratio (SNR) of a small value shunt is worse than using a larger value one. In this sense,
there may be chance that a shunt of higher value is desired, for example when measuring a very small
current and the range of current to be measured are also in a small range. Consider these factors for this
design: the maximum current, the current dynamic range, and the power dissipation.

In this application, the maximum current for each socket is 15 A, and the desired dynamic range of current
keeping flat error percentage is 1000:1. Keep the power dissipated on the shunt resistor as small as
possible.

To achieve the best accuracy, have the shunt sensor signal use the whole input range of the SD24.
Because the SD24 ADC has an input range of 900 mV at x1 gain, using a x16 gain the input range is

(1)

With this number, a 2-mΩ shunt resistance suits this input up to 19.5 A. Due to the limited area of copper
attached to the shunt resistor, however, use a smaller valued shunt to keep the heat accumulation on the
shunt resistor low, then choose a 0.5-mΩ shunt resistance.

In addition to value, the physical size of the shunt is also an important factor to accuracy—not the size
directly, but the heat generated when current flows. A smaller sized shunt heats up more easily due to the
limited surface area. If there is significant current to flow through the shunt, have a large enough sized
shunt and sufficient ventilation on the PCB to prevent heat being accumulated. In this design, a 2512 size
shunt is choose. At 0.5-mΩ, the power dissipate on the shunt at maximum current is 162 × 0.5 = 0.128 W,
which is about one-eighth the rated power of a 2512 size 1-W shunt resistor.
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3.2.2 Voltage Divider Circuit
For the voltage sensor circuit, the matter is a little simpler. In this design, the major consideration is that
the voltage divider should be able to prevent arcing between the terminals. To reduce the voltage
difference between resistor terminals, this design uses four resistors (instead of 2) to form the voltage
divider (R1, R13, and R14 are 330 kΩ, and R15 is 1.5 kΩ). Then the voltage across R1, R13, and R14
each take about one-third of the AC voltage. Now at 220-V input, each resistor has a voltage drop of
about 75 V. Using the 2512 resistor for R1, R13, and R14 then further separate the live voltage and R15.

The installation of D8 in the voltage sensor circuit is more important than D1 in the current circuit. The
reason is that the resistor ladder on the voltage sensor circuit is more likely to see a voltage surge across
R15 high enough to damage the MCU. If R15 is open circuit or in bad contact, causing a higher resistance
the voltage across the input of the voltage channel ADC also damages the MCU.

4 Software Description

4.1 Firmware Structure
The firmware is designed to use a layered approach, isolating the user from the details of metrology and
the associated computations involved to simplify the programming work.

In user's view, the firmware is partitioned into three main blocks:
• The application, which contains the function to perform system setup and initialization, main loop,

communication protocol and command handling, non-volatile parameters preset, and manipulation.
• The toolkit packaged, which is packed into a library named “emeter-toolkit-i2041.r43”, contains low-

level computation routines.
• The metrology computation engine, which is packaged into a library named “emeter-metrology-

i2041.r43”, contains the function for ADC setup and initialization, sample-based background
processing, reporting cycle-based foreground processing, and result reading API.

NOTE: This package does not include the source code of this library. Contact a local Texas
Instruments Sales Team if the source code is needed.
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4.2 Metrology Computation Engine
The metrology computation engine performs the actual sampling and computation based on the
information collected from the voltage and current ADC channels. The engine acts in a time-critical
background process and a less time-critical foreground process.

The background process is triggered by the ADC at the sample rate. This process runs in the interrupt
services routine of the ADC and is processed automatically.

The foreground process is triggered by the completion of background process at the reporting and update
rate. The background process sets the flag PHASE_STATUS_NEW_LOG in the variable phase_state to
indicate that data is ready to be processed by the foreground. The application then needs to monitor this
flag to trigger the foreground process by calling to calculate_phase_readings ().

In the actual computation, use the following formulas in the metrology computation:

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)

(10)

(11)

(12)

(13)
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4.2.1 Background Process
The background performs a straight-forward, time-critical, sample-based process. The process starts by
an interrupting trigger at the sample rate. The background process then
• Captures data from voltage and current ADC channels
• Performs voltage sample processing and line resistance compensation
• Performs current sample processing and capacitance compensation
• Performs power processing
• Performs fundamental power processing
• Performs line frequency processing and AC/DC mode test and switching
• Triggers the foreground process

4.2.2 Foreground Process
After reaching the report cycle, the background sets the flag PHASE_STATUS_NEW_LOG. The user
main loop checks the status of this flag and calls to the foreground process calculate_phase_readings () to
perform the rest of the computation and deliver the measurement readings, including
• Power processing

1. Calculate active power and reactive power
2. Calculate fundamental active and fundamental reactive power

• Voltage processing
1. Calculate the RMS voltage and fundamental RMS voltage

• Current processing
1. Calculate the RMS current and fundamental RMS current
2. Calculate the apparent power

• Other processing
1. Calculate the power factor
2. Calculate the frequency of the AC line
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5 Test Setup

5.1 Apparatus
The following list of instruments help calibrate and test the EVM (See the instrument link in Section 8):
• AC meter test set
• AC source that could output sufficient power to drive the load at a rated frequency (for example, 50 to

60 Hz) and a rated voltage (for example, 110 to 220 V) with a variable AC load or UUT. If DC
measurement is needed, use a variable DC load or UUT. Alternatively, an AC test set could generate
the rated loading

• A reference meter that could read AC parameters based on the voltage, current, and phase setting
from the AC meter test set

5.2 Setup

Figure 4. Setup
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6 Test Results

Table 1. Output C PF = 1, Cal at 7.50212 A, 1650.7 W

CURRENT CURRENT CURRENT POWER POWERCURRENT % POWER REF POWER %REF READ ERROR READ ERROR
0.014555 0.01476 0.000205 1.408% 3.202 3.213 0.011 0.355%
0.029637 0.029737 0.0001 0.339% 6.517 6.515 –0.002 –0.029%
0.074836 0.07495 0.000114 0.152% 16.579 16.615 0.036 0.217%
0.145378 0.145391 0.000013 0.009% 31.984 31.992 0.009 0.027%
0.295964 0.295992 0.000028 0.009% 65.114 65.168 0.054 0.083%
0.747332 0.747569 0.000237 0.032% 165.104 165.256 0.152 0.092%
1.50005 1.5 –0.00005 –0.003% 330.06 330.314 0.254 0.077%
2.98846 2.989 0.00054 0.018% 662.136 662.586 0.45 0.068%
7.50239 7.5 –0.00239 –0.032% 1650.38 1650.779 0.399 0.024%

14.35 14.32 -0.03 –0.209% 3090.24 3084.544 –5.696 –0.184%
19.3214 19.242 –0.0794 –0.411% 4162.29 4143 –19.29 –0.463%

Table 2. Output C PF = 0.5 L, Cal at 7.50212 A, 1650.7 W

CURRENT CURRENT CURRENT POWER POWERCURRENT % POWER REF POWER %REF READ ERROR READ ERROR
0.014558 0.014654 0.000096 0.659% 1.555 1.559 0.004 0.257%
0.029628 0.029774 0.000146 0.492% 3.173 3.168 –0.005 –0.158%
0.074823 0.074824 0.000001 0.001% 8.037 8.055 0.018 0.218%
0.145166 0.145141 –0.000025 –0.017% 13.287 13.298 0.011 0.083%
0.295495 0.295481 –0.000014 –0.005% 27.587 27.589 0.002 0.007%
0.747391 0.747393 0.000002 0.000% 71.399 71.492 0.093 0.130%
1.5001 1.5 –0.0001 –0.007% 165.134 165.379 0.245 0.148%
2.98839 2.989 0.00061 0.020% 319.346 319.745 0.399 0.125%
7.40232 7.4 –0.00232 –0.031% 596.562 596.954 0.392 0.066%
14.3712 14.354 –0.0172 –0.120% 890.268 889.965 –0.303 –0.034%
20.0216 19.914 –0.1076 –0.537% 2197.23 2187.52 –9.710 –0.442%

Table 3. Output C PF = 0.5 C, Cal at 7.50212 A, 1650.7 W

CURRENT CURRENT CURRENT POWER POWERCURRENT % POWER REF POWER %REF READ ERROR READ ERROR
0.014543 0.014671 0.000128 0.879% 1.659 1.652 –0.007 –0.422%
0.029624 0.029638 0.000014 0.046% 3.388 3.39 0.002 0.056%
0.074827 0.074848 0.000021 0.029% 8.525 8.537 0.012 0.141%
0.145314 0.145267 –0.000047 –0.032% 18.491 18.503 0.012 0.068%
0.295834 0.295752 –0.000082 –0.028% 37.381 37.391 0.01 0.027%
0.747077 0.747067 –0.00001 –0.001% 94.044 94.03 –0.014 –0.015%
1.48145 1.481 –0.00045 –0.030% 171.561 171.526 –0.035 –0.020%
2.98851 2.989 0.00049 0.016% 345.256 345.311 0.055 0.016%
7.40175 7.399 –0.00275 –0.037% 1025.61 1025.054 –0.556 –0.054%
14.3347 14.318 –0.0167 –0.117% 2196.37 2190.308 –6.062 –0.276%
19.304 19.241 –0.063 –0.326% 2965.78 2951.4 –14.38 –0.485%
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Figure 5. Power Percentage Error versus Load Current

NOTE: From the above graph, the error begins to go negative the higher current. This phenomenon
is due to the shunt heating up by the current flowing through the traces on the board. At a
low current, the higher error is mostly caused by noise, causing unstable readings.
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Table 4. Typical Accuracy versus Temperature

VOLTAGE (V) CURRENT (A) POWER (W)
TEMP (°C) V VREF V% I IREF I% P PREF P%

0 219.786 219.991 –0.093% 5.005 5.000 0.097% 1100.730 1099.940 0.072%
5 219.728 219.978 –0.114% 5.005 5.000 0.088% 1099.470 1099.860 –0.035%
10 219.801 219.992 –0.087% 5.005 5.000 0.082% 1100.050 1100.040 0.001%
15 219.839 219.997 –0.072% 5.004 5.000 0.072% 1100.110 1100.020 0.008%
20 219.896 220.013 –0.053% 5.003 5.000 0.053% 1100.120 1099.920 0.018%
25 219.883 219.954 –0.032% 5.002 5.000 0.025% 1100.050 1099.830 0.020%
30 219.951 220.021 –0.032% 4.998 5.000 –0.040% 1099.680 1099.930 –0.023%
35 219.990 220.060 –0.032% 4.996 5.000 –0.088% 1099.290 1099.960 –0.061%
40 220.012 220.021 –0.004% 4.993 5.000 –0.142% 1098.910 1100.060 –0.105%
45 220.060 220.054 0.003% 4.991 5.000 –0.193% 1098.330 1099.840 –0.137%
50 220.054 220.053 0.000% 4.988 5.000 –0.256% 1097.580 1099.920 –0.213%
55 220.026 219.996 0.014% 4.983 5.000 –0.343% 1096.890 1099.910 –0.275%
60 220.050 220.027 0.010% 4.979 5.000 –0.427% 1095.800 1099.890 –0.372%
65 220.009 220.051 –0.019% 4.974 5.000 –0.522% 1094.700 1100.020 –0.484%
70 219.968 219.995 –0.012% 4.969 5.000 –0.630% 1093.210 1099.940 –0.612%
75 219.896 219.973 –0.035% 4.969 5.000 –0.629% 1093.060 1100.030 –0.634%
80 219.892 219.952 –0.027% 4.969 5.000 –0.637% 1092.600 1099.960 –0.669%
85 219.895 219.957 –0.028% 4.968 5.004 –0.704% 1092.840 1099.910 –0.643%

Figure 6. Typical Accuracy versus Temperature

NOTE: From the above graph, the error begins to go negative the higher temperature. This
phenomenon is due to the board heating up and the combined temperature coefficient of the
whole board is in effect.
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7 Design Files

7.1 Schematics
To download the schematics, see the design files at TIDM-SERVER-PWR-MON.

Figure 7. i2040 Sub-Meter EVM Schematics
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7.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDM-SERVER-PWR-MON.

Table 5. BOM

MANUFACTURERITEM QTY REFERENCE VALUE PART DESCRIPTION MANUFACTURER PCB FOOTPRINT NOTEPARTNUMBER
1 1 !PCB Printed circuit board Printed circuit

board
2 1 C4 470 nF CAP, CERM, 470 nF Taiyo Yuden EMK107F474ZA-T 0603 Product Page Link

Panasonic
3 1 R18 2.2 k RES, 2.2 kΩ, x%, xW, [PackageReference], Electronic ERJ-3GEYJ222V 0603 Product Page Link

Components
RES, open ohm, x%, xW,4 1 R19 Open 0603 Open[PackageReference],

Panasonic
5 1 R20 1 k RES, 1 kΩ, x%, xW, [PackageReference] Electronic ERJ-3GEYJ102V 0603 Product Page Link

Components
Panasonic

6 1 R21 2.2 k RES, 2.2 kΩ, x%, xW, [PackageReference] Electronic ERJ-3GEYJ222V 0603 Product Page Link
Components
Panasonic

7 1 R22 68 RES, 68 Ω, x%, xW, [PackageReference] Electronic ERJ-3GEYJ680V 0603 Product Page Link
Components
Panasonic

8 1 R23 1 k RES, 1 kΩ, x%, xW, [PackageReference] Electronic ERJ-3GEYJ102V 0603 Product Page Link
Components
Panasonic

9 1 R24 10 k RES, 10 kΩ, x%, xW, [PackageReference] Electronic ERJ-3GEYJ103V 0603 Product Page Link
Components
Panasonic

10 1 R25 1.5 k RES, 1.5 kΩ, x%, xW, [PackageReference] Electronic ERJ-3GEYJ152V 0603 Product Page Link
Components
Panasonic

11 1 R26 220 RES, 220 Ω, x%, xW, [PackageReference] Electronic ERJ-3GEYJ221V 0603 Product Page Link
Components

CAP, CERM, 47 pF, 50 V, ±5%, C0G/NP0, Murata Electronics GRM1555C1H47012 4 C8, C9, C12, C13 47 pF 0402 Product Page Link0402 North America JZ01
CAP, CERM, 0.015 µF, 50 V, ±10%, X7R, Murata Electronics GRM155R71H15313 2 C10, C14 0.015 µF 0402 Product Page Link0402 North America KA12D
CAP, CERM, 0.1 µF, 10 V, ±10%, X5R,14 2 C11, C20 0.1 µF TDK Corporation C1005X5R1A104K 0402 Product Page Link0402
CAP, TANT, 10 µF, 10 V, ±20%, 2.5 Ω, 293D106X0010B215 1 C19 10 µF Vishay Sprague 3528-21 Product Page Link3528-21 SMD TE3
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Table 5. BOM (continued)
MANUFACTURERITEM QTY REFERENCE VALUE PART DESCRIPTION MANUFACTURER PCB FOOTPRINT NOTEPARTNUMBER

CAP, CERM, 2.2 nF, 25 V, ±10%, X7R,16 1 C21 2.2 n AVX Corporation 0805ZC222JAT2A 0805 Product Page Link0805
CAP, CERM, 0.1uF, 50V, +/-10%, X7R,17 2 C24, C25 0.1 µF TDK Corporation C1608X7R1H104K 0603 Product Page Link0603
CAP, TANT, 10 µF, 50 V, ±10%, 0.8 Ω,18 2 C26, C27 10 µF AVX Corporation F931D106KAA 7343-43 Product Page Link7343-43 SMD
CAP, TANT, 220 µF, 6.3 V, ±10%, 0.6 Ω, TCJB227M006R0219 1 C28 220 µF AVX Corporation 7343-31 Product Page Link7343-31 SMD 00

20 2 D1, D8 Littelfuse Inc SMAJ5.0CA DSO-C2/X1.8 Product Page Link
Vishay

21 4 D2, D3, D4, D5 Semiconductor LL103A SOD-80 Product Page Link
Diodes Division

22 1 D6 Littelfuse Inc V320SM7 V320SM7 Product Page Link
23 1 D7 7 V Diode, TVS, Uni, 7 V, 600 W, SMB Diodes SMBJ7.0A-13-F SMB Product Page Link

Incorporated
24 1 FR Fuse, 1 A,125 V, SMD Cooper Bussmann 6125FA1A 6125FA Product Page Link

Machine screw, round, #4-40 × 1/4, nylon, NY PMS 440 0025 NY PMS 440 002525 4 H1, H2, H3, H4 Not populatedPhilips panhead PH PH
26 4 H5, H6, H7, H8 Standoff, Hex, 0.5"L #4-40 Nylon 1902C Keystone_1902C Not populated

N/A (3.5-mm
diameter throughHole for Banana27 1 J1 LIVE_IN hole only, noSocket component
populated)
N/A (3.5-mm
diameter throughHole for Banana28 1 J2 LIVE_OUT hole only, noSocket component
populated)
N/A (3.5-mm
diameter throughHole for Banana29 1 J3 NEUTRAL_IN hole only, noSocket component
populated)
N/A (3.5-mm
diameter throughHole for Banana30 1 J4 NEUTRAL_OUT hole only, noSocket component
populated)

Header, TH, 100 mil, 2×2, gold plated, 23031 1 J5 TE Connectivity TSW-102-07-G-D TSW-102-07-G-D Product Page Linkmil above insulator
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Table 5. BOM (continued)
MANUFACTURERITEM QTY REFERENCE VALUE PART DESCRIPTION MANUFACTURER PCB FOOTPRINT NOTEPARTNUMBER

Sullins Connector 1.27mm pitch 6-pin header32 1 J6 Product Page LinkSolutions socket (1.27mm)
33 1 J7 Receptacle assembly, 9 position, right angle TE Connectivity D Connector 9 DSUB1.385-2H9 Product Page Link

Header, TH, 100 mil, 1×3, gold plated, 230 Sullins Connector34 1 J8 1 x 3 PBC03SAAN PBC03SAAN Product Page Linkmil above insulator Solutions
35 1 J9 Header, 4-Pin 100 mil 1×4 TE Connectivity Header 4 A31114-ND Product Page Link

Inductor, [Technology], [Material], xxuH, Murata Electronics BLM21BD121SN136 2 L1, L2 0805 Product Page LinkxxA, x.xx ohm, [MountType] North America D
Thermal transfer printable labels, 0.650" W37 1 LBL1 Size: 0.65" x 0.20 " Label_650x200 Not populated× 0.200" H - 10,000 per roll

38 2 LED1, LED5 Red Lite-On Inc LTST-C170KRKT 0805-LED Product Page Link
39 2 LED2, LED6 Green Lite-On Inc LTST-S220KGKT 0805-LED Product Page Link
40 2 LED3, LED7 Blue Lite-On Inc LTST-C170TBKT 0805-LED Product Page Link
41 1 LED4 White Lite-On Inc LTW-170TK 0805-LED Product Page Link
42 1 P1 Header, 7-pin, dual row TE Connectivity A104860-ND 2X7BOXHEADER Product Page Link

Micro Commercial43 2 Q1, Q2 0.075 V Transistor, PNP, 45 V, 0.1 A, SOT-23 BC857B SOT-23 Product Page LinkCo
PanasonicRES, 330 kΩ, 1%, 1 W, 2010, RES, 330 kΩ,44 3 R1, R13, R14 330 k Electronic ERJ-S1DF3303U 2010M Product Page Link5%, 1 W, 2010 Components

RES, 1.5 kΩ, 1%, 1 W, 2010, RES, 330 kΩ, Rohm45 1 R15 1.5 k MCR50JZHF1501 2010M Product Page Link5%, 1W, 2010 Semiconductor
PanasonicR2, R3, R4, R5, R7,46 7 390 RES, 390 Ω, 5%, 0.125 W, 0805 Electronic ERJ-6GEYJ391V 0805 Product Page LinkR12, R17 Components
International ULRB12512R0005 Current Sensing47 1 R6 500 µΩ Shunt resistor Product Page LinkResistive FLFSLT Pad

CRCW04021K00F48 3 R8, R9, R11 1.00 k RES, 1.00 kΩ, 1%, 0.063 W, 0402 Vishay Dale 0402 Product Page LinkKED
CRCW0402100RF49 1 R10 100 RES, 100 Ω, 1%, 0.063 W, 0402 Vishay Dale 0402 Product Page LinkKED
CRCW04024K70J50 1 R16 47 k RES, 47 kΩ, 5%, 0.063 W, 0402 Vishay Dale 0402 Product Page LinkNED

R27, R28, R29, R30,51 7 Open RES, open Ω, x%, Open 0805 OpenR31, R36, RA3
Panasonic

52 1 R32 1.5 k RES, 1.5 kΩ, x%, Electronic ERJ-6GEYJ152V 0805 Product Page Link
Components
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Table 5. BOM (continued)
MANUFACTURERITEM QTY REFERENCE VALUE PART DESCRIPTION MANUFACTURER PCB FOOTPRINT NOTEPARTNUMBER

Panasonic
53 1 R33 1.5 k RES, 1.5 kΩ, x%, Electronic ERJ-6GEYJ152V 0805 Product Page Link

Components
Panasonic

54 1 R35 0 R RES, 0 Ω, x% Electronic ERJ-6GEY0R00V 0805 Product Page Link
Components
Panasonic

55 1 R34 330 RES, 330 Ω, x%, xW, [PackageReference] Electronic ERJ-6GEYJ331V 0402 Product Page Link
Components

56 1 U1 MSP430i2040 Texas Instruments MSP430i2040PW TSSO10x6-G28
57 2 U2, U3 PS8802-1 CEL PS8802-1 SO-8 Product Page Link
58 1 U4 Onboard block power supply CUI Inc VSK-S1-3R3U VSK-S1 Product Page Link
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7.3 PCB Layout
To download the layer plots, see the design files at TIDM-SERVER-PWR-MON.

Figure 8. Top Layer Figure 9. Bottom Layer

Figure 10. Top Overlay Figure 11. Top Solder Paste

Figure 12. Top Solder Mask Figure 13. Bottom Solder Mask
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Figure 14. Bottom Solder Paste Figure 15. Bottom Overlay

Figure 16. Board Outline

Figure 17. Drill Drawing Figure 18. Drill Guide
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7.4 Altium Project
To download the Altium project files, see the design files at TIDM-SERVER-PWR-MON.

Figure 19. Altium Project Image 1

7.5 Gerber Files
To download the Gerber files, see the design files at TIDM-SERVER-PWR-MON
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7.6 Assembly Drawings
To download the assembly files, see the design files at TIDM-SERVER-PWR-MON.

Figure 20. Assembly Drawing Layer 1 Figure 21. Assembly Drawing Layer 2

7.7 Software Files
To download the software files, see the design files at TIDM-SERVER-PWR-MON.

8 References

1. KP-P3001-C AC Meter Test Set (link)
2. HC 3100 Reference Meter (link)
3. Chroma 61500 Series LOW POWER Programmable AC Source (link)
4. Chroma 66201 and 66202 Reference Meter (link)
5. Chroma 6310/A Series Modular DC Electronic Load (link)
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Appendix A Example Application Code

A.1 Introduction
Project structure:
• emeter-communication.c – source code for low level UART communication routines including UART

port setup, write and read from UART, interrupt services routine for byte-wise send and receive
• emeter-dlt645.c – source code for the polling mode protocol implementation
• emeter-main.c – source code for system initialization, main loop, callback functions implementation and

interrupt vector placement
• emeter-metrology-i2041.r43 – embedded metering library object code
• emeter-setup.c – source code for low level system initialization
• emeter-template.h – source code for configuration
• metrology-calibration-default.c – source code to put the user defined default calibration parameter into

a proper data structure (should not modify this file)
• metrology-calibration-template.h – source code of user defined default calibration parameter
• emeter-autoreport.c – source code for performing auto reporting.

NOTE: To enable auto report support uncomment the #define AUTOREPORT_SUPPORT definition
in emeter-template.h.)
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A.2 Preparing the Application Code to Run

1. Launch the IAR5.5 Embedded Workbench IDE and click on File→Open→Workspace.
2. Select “emeters.eww” when prompted to open Workspace.

Figure 22. Opening Workspace

3. Select the emeter-app-i2041 project tab at the bottom of the Workspace window.
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4. Check project options by right clicking the project name and select Options… from the pop-up menu
(see Figure 23).

Figure 23. Project Tab

5. When the options appear, select C/C++ Compiler on the left-hand column. Then select the
Optimizations tab on the right-hand side and check the optimization settings as shown in Figure 24.

Figure 24. Optimization Options
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6. Select FET Debugger on the left-hand column, then select the Setup tab. The EVM uses Spy-Bi-Wire
for its code downloading and debugging. Check to make sure the options are as shown in Figure 25.

Figure 25. Debugger Options

7. Select the Download tab. Under Flash erase, do not choose Erase main memory and Information
memory; this option erases both sets of data and cannot be recovered. Instead, choose Erase main
memory as the download option to preserve these factory parameters: system clock calibration, ADC
calibration, and internal reference calibration (see Figure 26). However, metrology calibration stored in
the main memory, such as VGAIN, IGAIN, PGAIN, and so on, are always erased after downloading.

Figure 26. Download Options

8. Click OK after all of the changes are made.
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9. Rebuild the project by right-clicking on the project and select Rebuild All from the pop-up menu (see
Figure 27). Three warnings will be reported during rebuilding (see Figure 28), which are safe to ignore.
To open the project workspace and modify, compile, and download the code, the user must have IAR
Embedded Workbench 5.5 installed with a valid license. If a valid license is not available, the user can
still download the object code. See Section A.3 for downloading procedures.

Figure 27. Compiling the Application

Figure 28. Warnings
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10. Make sure the jumper on J8 is short properly. Connect the 14-pin connector P1 to MSP-FET430UIF by
a flat cable as shown in Figure 29.

CAUTION
The debugging interface is not isolated. Make sure to
properly isolate between the EVM and the PC used for
debugging with AC or DC high voltage connected.

NOTE: Connection to debugging interface is optional for the operation of the EVM. The EVM can
operate without a debugger connected.

Figure 29. Connecting EVM and FET
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11. Click the Download and Debug button to download and debug (see Figure 30).

Figure 30. Code Downloading
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12. After successfully completing the download, Figure 31 appears. Click Go to run the application.

Figure 31. Debugger Screen

Figure 32. EVM Running
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A.3 Downloading without an IAR License
If a valid IAR Embedded Workbench 5.5 license is not available, download the executable code to the
board with the following steps using the installed IAR Embedded Workbench 5.5.
1. Open the project workspace as described in Section A.2, Steps 1 through 7. Then connect the board to

the MSP-FET430UIF as described in Step 10 in Section A.2.
2. Select Project→Download→Download File… from the menu (see Figure 33).
3. When prompted to select a file, go to the folder [Submeter i2040

8k_DC_THD_AUTO_OSR_IAR5.5]\emeter-app\emeter-app-i2041\Debug\Exe and select the file
named “emeter-app-i2041.d43” (Figure 34).
The executable code will then download to the board.

Figure 33. Download Executable File

Figure 34. Select File to Download
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Appendix B EVM Operation

B.1 Download Application Code
Download application to the board by using the IAR compiler as described in Appendix A.

B.2 Setting up the PC Software Tool
Unzip the file named "calibrator-runtime.zip” into any folder. A folder named "calibrator-runtime” containing
the necessary files to run the software tool will be in that folder. The file named "calibrator-20121120.exe"
is the executable file of the software tool. The file named “calibrator-config.xml" contains the setup
information for the software tool. Users must make a few edits to this XML file before calibrator-
20121120.exe can launch.

Follow these steps to setup the XML to run calibrator-20121120.exe properly:
1. Right click the My Computer icon and select Properties in the pop-up menu.
2. Select the Hardware tab in the System Properties window, then click on the Device Manager to go to

its window.

Figure 35. System Properties Window
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3. Check the COM port number of the serial port that connects the PC and the EVM.

Figure 36. Device Manager Window
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4. Open “calibration-config.xml” in the folder “calibrator-runtime” with a text or XML editor. Go to the line
highlighted in Figure 37, put in the COM port number in, and save the file.

Figure 37. Editing “calibration-config.xml”
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B.3 Setup the EVM Hardware

CAUTION
Do not supply power to the EVM until the hardware
and software setup is completed.

1. Install jumpers to J5 as shown in Figure 38.
2. Connect AC/DC source to LIVE_IN and NEUTRAL_IN. Connect test load to LIVE_OUT and

NEUTRAL_OUT.
3. Connect the serial connector to the PC serial port with a serial cable.
4. Apply AC/DC source power.

Figure 38. Jumpers
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B.4 Start Using the EVM
When the EVM has been powered, some of the LEDs will flash or turn on to indicate its operation status
while the other LEDs are not used. The user can change the provided source code to make use of all
seven LEDs as needed. Table 6 lists how each LED is used.

Table 6. LED Status

LED STATE INDICATION
LED1 ON Background operations running
LED1 OFF Background operations completed
LED2 ON Negative voltage half cycle
LED2 OFF Positive voltage half cycle
LED3 ON Not used
LED3 OFF Not used
LED4 ON Foreground operations running
LED4 OFF Foreground operations completed
LED5 ON EVM is in AC mode measurement
LED5 OFF EVM is not in AC mode measurement
LED6 ON EVM is in DC mode measurement
LED6 OFF EVM is not in DC mode measurement
LED7 ON Active energy pulse pulsing
LED7 OFF Active energy pulse idle

To run the readied EVM, launch the software “calibrator-20121120.exe” in the folder “calibration-runtime”
to start communicating with the EVM. A window as shown in Figure 39 appears. As defined in the XML file
“calibration-config.xml”, meter position 1 is assigned the serial port to communicate with the EVM. The
Comms indicator will turn green if communication to EVM from PC is established, and it will flash between
red and green when the communication takes place.

Figure 39. Calibrator Software Startup Window
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Click on the Comms indicator to show the Meter status window as shown in Figure 40.

Figure 40. Meter Status Window

This window shows the current reading of the meter. The background of a reading box is gray if the EVM
does not support that particular reading. The box turns red if the reading from EVM to that box has a large
variance, yellow if the reading from EVM has a fairly low variance, and green if the reading has a low
variance.

NOTE: The software on PC reads the EVM every second and averages the data read, meaning the
update rate is slower than the update rate of the EVM.
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At the bottom of this window, there are four buttons.
• The Meter consumption button brings up the Meter consumption window. This window gives no useful

information because the EVM does not support this feature.
• The Meter calibration factors button brings up the Meter calibration factors window, which shows the

current calibration factor values (see Figure 41).

Figure 41. Meter Calibration Factors Window

• The Meter features button brings up the Meter features window. This window reports the support
feature of the EVM (see Figure 42, which only shows the look and feel of the Meter features window,
not the exact feature of the EVM).

Figure 42. Meter Features Window
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• Click on the Manual cal button brings up the Manual cal window (Figure 43). In this window, adjust the
calibration factor values by entering the percentage error of the reading from the EVM and compare to
the reading from the reference meter. The technique and procedure of performing calibration will be
discussed in further detail in Appendix C.

Figure 43. Meter Error Window

To modify the calibration factor, enter the correction in the percentage error. The percentage error is
calculated as follows:

(14)

Put the percentage error into its corresponding box in the Meter calibration window. Click Update meter to
calculate and write the updated calibration values to the EVM. The corresponding values will be reflected
on the Meter calibration factor window (Figure 41).

B.5 Known Issues
The calibrator software is legacy software that operates with utility meters that have not been customized
completely for embedded metering. The following is a list of known issues with the existing software that
will be fixed in the next version of calibrator software customized for embedded metering.
• Neutral monitoring is shown in the Meters features window as a supported feature, which is incorrect.

When wire resistance compensation or inlet capacitor compensation is enabled, the calibrator will
interpret it as neutral monitoring support.

• Resistance values of wire resistance compensation and capacitance value of inlet capacitor
compensation cannot be programmed with calibrator software.

• Voltage AC offset values cannot be written with the calibrator software. The value put into the voltage
AC offset box is written to the current AC offset instead. The value put into the current AC offset box
has no effect.

• DC offset values cannot be written to the EVM with the calibration software. The current firmware takes
the current and voltage DC offset value every time any calibration value is updated.

• The aggregate current in Meter status windows always shows 10.0000 A.
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Appendix C EVM Calibration

C.1 Introduction
The EVM is programmed with calibration values that allow the EVM to give roughly accurate readings;
however, the EVM has not been calibrated while shipped. To maximize accuracy and to compensate
component and manufacturing tolerance, the EVM must go through a calibration process. This chapter will
discuss the techniques, procedures, and steps of calibration.

C.2 Calibration Techniques
The calibration of the EVM is defined based on the front-end interface model as shown in Figure 44.

Figure 44. Front-End Interface Model

This design requires a two-point calibration. VGAIN, IGAIN, PGAIN, VDC_OFFSET, and IDC_OFFSET
are parameters that will be calibrated during the process; an estimated value is put into the memory during
the design and characterization to help to speed up calibration.

NOTE: Default CAP and RES should set to 0 before calibration.

VAC_OFFSET, IAC_OFFSET, PHASE_CORRECT are parameters that may not need calibration but a
characterization would be sufficient for embedded metering application except for a high accuracy of
<0.1%.

NOTE: The calibration values are written in one flash page in the EVM, so when a new value needs
to be written the whole page is erased. The provided GUI will do the read, modify, and write
operations automatically. When using a user calibration facility, read the complete set of
calibration values, back them up, update the modified field, and write the complete set back
to the EVM.
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C.3 Calibration Procedures

C.3.1 Calibration of AC and DC Parameters
Use the following steps to calibrate the AC and DC parameters.

Calibrating VGAIN

1. Set to No/Lowest possible load.
2. Set VIN to line voltage.
3. Calculate the value for VGAIN with the formula

where
• VGAINn+1 is the new voltage calibration factor
• VGAINn is the original voltage calibration factor
• VREF is the reference meter voltage reading at the voltage set for VGAIN calibration
• VUUT is the unit under test voltage reading at the voltage set for VGAIN calibration (15)

or, if percentage error is used (as with the provided calibration software),

(16)
4. Write and apply the calibrated VGAIN.

Calibrating IGAIN

1. Set VIN to line voltage.
2. Set to High / Highest possible load.
3. Calculate IGAIN value with the formula

where
• IGAINn+1 is the new current calibration factor
• IGAINn is the original calibration factor
• IREF is the reference meter current reading at the current set for IGAIN calibration
• IUUT is the unit under test current reading at the current set for IGAIN calibration (17)

or, if percentage error is used (as with the provided calibration software),

(18)
4. Write and apply the calibrated IGAIN.

Calibrating PGAIN

1. Use the same conditions as Calibrating VGAIN and Calibrating IGAIN with the power factor = 1.
2. Note the percentage error on voltage at this point.
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3. Calculate PGAIN gain so that power is of the same percentage error as voltage at this point:

where
• PGAINn+1 is the new power calibration factor
• PGAIN is the original power calibration factor
• PREF is the reference meter power reading at the power set for PGAIN calibration
• PUUT is the unit under test power reading at the power set for PGAIN calibration (19)

or, if percentage error is used (as with the provided calibration software),

(20)
4. Write and apply the calibrated PGAIN.

C.3.2 Calibration of Compensation Resistance and Capacitance
After calibrating VGAIN, IGAIN, and PGAIN, follow these steps to calibrate the compensation to wire
resistance and EMI capacitance.

Calibrating RES

1. Calculate RES with the given equation:

where
• RWIRE is the estimated wire resistance
• VREF(Imax) is the reference meter voltage reading at the current set for IGAIN calibration
• VUUT(Imax) is the unit under test voltage reading at the current set for IGAIN calibration
• Imax is the current set for IGAIN calibration (21)

2. Write and apply the calibrated RES.

NOTE: The resistance is in 1/256-Ω units.

Calibrating CAP

1. Set to No / Lowest possible load.
2. Set VIN to low line voltage.
3. Calculate CAP with the given equation:

where
• C is the estimated EMI filter capacitance
• V is the voltage set for calibration of C
• Papparent_REF is the apparent power reading of the reference meter at the setting for this calibration
• Papparent_UUT is the apparent power reading of the unit under test at the setting for this calibration
• Pactive is the active power reading of the reference meter (suppose ut is already calibrated to be the same as

the active power reading of UUT) (22)
4. Write and apply the calibrated CAP.

NOTE: The capacitance is in 1/64-μF units.
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C.3.3 Calibration of Current AC Offset
The current AC offset is the result of noise pickup, and the offset generated on the shunt resistor circuit
causes an illusion of having a finite current flowing when there is actually not current flowing through the
shunt. Although this noise current does not affect the power reading's accuracy, this illusion contributes to
the current reading and its accuracy, especially when the current is small. To offset this miscalculation, the
EVM firmware has the mechanism to remove this from the current reading. The steps to calibrate this
current offset are as follows:
1. Apply nominal voltage to make sure the EVM operates.
2. Remove all loading from the EVM.
3. Take multiple current readings (for example, 100) and take an average as I_NOISE (in A).
4. Calculate the current AC offset value with the equation

(23)

NOTE: This is a big number even in the case of a few mA of noise.

5. Write and apply the calibrated I_AC_OFFSET.

C.3.4 Calibration of Voltage AC Offset
In most cases, the voltage AC offset rarely affects the voltage reading and does not require calibration.

C.3.5 Calibration of Phase Correction

1. Set the test set to generate rated voltage and set to calibration current (for example, 5 A).
2. Make sure calibrations are complete for PGAIN (at PF = 1).
3. Set the test set to output at power factor 0.5 (+ or – is not important at this point).
4. Note the power error.
5. Switch the test set to output at power factor 0.5 in the other direction to Step 3.
6. Note the power error.
7. At this point, both power errors should be approximately the same deviation but a different direction

from the calibrated power error at PF = 1.
• For example, at PF = 1, the calibrated error is 0.1%. If at PF = 0.5, the power error reads about

0.5%. Then at PF = –0.5, the power error should read about –0.3%.
8. Adjust the phase correction with time deviation from the current phase correction such that the power

errors at PF = ±0.5 are minimized.
• For example, if the current phase correction is 13 µs and 11 µs is desired, enter –2 into the phase

correction box of the manual calibration window.

C.3.6 Calibration of DC Parameters
This EVM design calibrates the AC and DC measurement parameters simultaneously. The DC
measurement parameters update automatically in the last step of calibration.

In fact, whenever the complete set of calibration values is read, the most up-to-date DC measurement
parameters are also included in the set. When other parameters update, the DC measurement parameter
also update to the most current value. However, the value is most accurate when current is low (best with
not current at all). As such, update the DC measurement parameter after the I_AC_OFFSET calibration.

NOTE: This may not be a user friendly way of setting DC measurement parameters. The procedure
of having the best DC measurement parameters will be modified and improved when the
embedded metering customized calibration software is released.
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Appendix D EVM Specification

• Voltage operating range (with supplied power supply): 85 to 265-V AC, 120 to 380-V DC
• Sample rate: 8000 Hz
• Sampling bit depth: 24 bits
• Polling report supported
• Update rate: Four AC cycles (AC mode), 80 ms (DC mode)
• UART communication data rate: 9600 bps
• AC/DC measuring mode switching: Four AC cycles (AC to DC), 80 ms (DC to AC)
• Measurements: RMS voltage, RMS current, active power, reactive power, apparent power, power

factor, line frequency, and temperature
• Measurement voltage range: 0 to 265 VRMS AC, 0 to ±380-V DC (using reference design circuit and

component values)
• Measurement current range: 0 to 15 ARMS AC, 0 to ±22.5-A DC (using reference design circuit and 0.5-

mΩ shunt values)
• Voltage resolution: 1 mV
• Current resolution: 1 µA
• Active Power resolution: 1 mW
• Reactive/apparent power resolution: 1 mW
• Power factor resolution: 0.001
• Frequency resolution: 0.01 Hz
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Appendix E Running on MSP430i2040 and MSP430i2041

The example IAR project has been configured for MSP430i2041. To run on MSP430i2040, follow these
steps once:
1. Open the workspace. After launching IAR 5.5, select File→Open→Workspace.

Figure 45. IAR 5.5 Launch Window
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When prompted to open the project, select emeters.eww from the project directory of the example
code.

Figure 46. Open Workspace Window

2. Set the option. Right click on the project emeter-app-i2041 and select Options...

Figure 47. Workspace Options

45TIDU454A–August 2014–Revised August 2014 Running on MSP430i2040 and MSP430i2041
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU454A


Appendix E www.ti.com

In the Options window, click on General Options on the left-hand column and then select the Target
tab. Then, in the Device section, click on the right-hand side button of the entry box and select
MSP430Ixxxx Family→MSP430I2040.

Figure 48. Options Window

Click on Linker in the left-hand column and select the Config tab. Then click on the right-hand button in
the Linker configuration file box.

Figure 49. Config Tab
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Select lnk430i2040_temp.xcl when prompted and click Open.

Figure 50. Selecting Default XCL File

When brought back to the Options window, click OK.

Figure 51. Finishing the Setting Changes
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When brought back to the main screen, select File→Save to save the setting.

Figure 52. Saving the Setting Changes

The project is now set for run on MSP430i2040. To have the project to run back on MSP430i2041, follow
the same steps except select MSP430Ixxxx Family→MSP430I2041 in the Options window and select
lnk430i2041_temp.xcl when prompted in the Linker configuration file box.
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IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated ("TI") reference designs are solely intended to assist designers (“Buyers”) who are developing systems that
incorporate TI semiconductor products (also referred to herein as “components”). Buyer understands and agrees that Buyer remains
responsible for using its independent analysis, evaluation and judgment in designing Buyer’s systems and products.
TI reference designs have been created using standard laboratory conditions and engineering practices. TI has not conducted any
testing other than that specifically described in the published documentation for a particular reference design. TI may make
corrections, enhancements, improvements and other changes to its reference designs.
Buyers are authorized to use TI reference designs with the TI component(s) identified in each particular reference design and to modify the
reference design in the development of their end products. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL
OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY THIRD PARTY TECHNOLOGY
OR INTELLECTUAL PROPERTY RIGHT, IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right,
or other intellectual property right relating to any combination, machine, or process in which TI components or services are used.
Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
TI REFERENCE DESIGNS ARE PROVIDED "AS IS". TI MAKES NO WARRANTIES OR REPRESENTATIONS WITH REGARD TO THE
REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ACCURACY OR
COMPLETENESS. TI DISCLAIMS ANY WARRANTY OF TITLE AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, QUIET POSSESSION, AND NON-INFRINGEMENT OF ANY THIRD PARTY
INTELLECTUAL PROPERTY RIGHTS WITH REGARD TO TI REFERENCE DESIGNS OR USE THEREOF. TI SHALL NOT BE LIABLE
FOR AND SHALL NOT DEFEND OR INDEMNIFY BUYERS AGAINST ANY THIRD PARTY INFRINGEMENT CLAIM THAT RELATES TO
OR IS BASED ON A COMBINATION OF COMPONENTS PROVIDED IN A TI REFERENCE DESIGN. IN NO EVENT SHALL TI BE
LIABLE FOR ANY ACTUAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES, HOWEVER CAUSED, ON ANY
THEORY OF LIABILITY AND WHETHER OR NOT TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, ARISING IN
ANY WAY OUT OF TI REFERENCE DESIGNS OR BUYER’S USE OF TI REFERENCE DESIGNS.
TI reserves the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per
JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant
information before placing orders and should verify that such information is current and complete. All semiconductor products are sold
subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms
and conditions of sale of semiconductor products. Testing and other quality control techniques for TI components are used to the extent TI
deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not
necessarily performed.
TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.
Reproduction of significant portions of TI information in TI data books, data sheets or reference designs is permissible only if reproduction is
without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for
such altered documentation. Information of third parties may be subject to additional restrictions.
Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards that
anticipate dangerous failures, monitor failures and their consequences, lessen the likelihood of dangerous failures and take appropriate
remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in
Buyer’s safety-critical applications.
In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.
No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties
have executed an agreement specifically governing such use.
Only those TI components that TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components that
have not been so designated is solely at Buyer's risk, and Buyer is solely responsible for compliance with all legal and regulatory
requirements in connection with such use.
TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.IMPORTANT NOTICE
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